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Abstract The paper provides an account of the principal components regression (PCR) and uses some examples from the
literature to illustrate the following: (1) the importance of PCR in the presence of multicollinearity; (2) some cautions on its
correct implementation in SPSS, as some researchers use it improperly; (3) the use of the correct formulas, in accordance with
the choice of scaling the variables; (4) the choice of principal components to be dropped; (5) the conditions for the PCR to
outperform ordinary least squares, in the minimum mean-square-error sense; and (6) the robustness of the estimates to

substantial changes in the sample.
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1. Introduction

A problem that is frequently encountered in applied
regression analysis is multicollinearity, i.e., high correlation
among the explanatory variables (regressors), which causes
the estimates to be imprecise, thus leading to erroneous
inferences and imprecise forecasts. As Jackson (2003, p. 276)
notes, a “salvation in some thorny regression problem” of
this type may be achieved by using principal components
(PCs) analysis. Unfortunately, however, some researchers
often fail to implement it properly, despite the strong
warnings that exist in the literature; see, e.g., Jolliffe (1982)
and Hadi and Ling (1998).

For example, in a well cited paper, Liu, et al. (2003) drop
the regressors that are not statistically significant at the
5-percent level before applying the principal components
regression (PCR). This can lead to a wrong model, however,
thus causing an omitted-variable bias, when in fact
multicollinearity is to blame for the low values of the
t-statistics, which, therefore, should not be taken to mean that
the corresponding regressors are irrelevant (Chatterjee and
Hadi, 2006, p. 299).

Also, Liu, et al. (2003) erroneously interpret the
“component matrix” (produced by the SPSS Factor Analysis
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procedure) as the matrix of eigenvectors, which can be
obtained by writing a program, or by modifying the
“component matrix” (see section 3). Apparently, as Sharma
(1996, p. 58) notes, this confusion often arises in packages
where principal component analysis is embedded in the
factor analysis procedure.

Finally, instead of using only a subset of the PCs in the
model, Liu, et al. (2003) use all of them. Unless other errors
are made, however, this procedure will return the original
regression, thus nullifying the whole effort of implementing
the PCR. Despite these errors, researchers still use Liu, et al.
(2003) as a hasic reference for the PCR, however; see, e.g.,
Ding, Ma, and Wang (2018) and Tran, et al. (2018).

The present paper provides an account of the PCR
(Section 2) and shows (in Section 3) step-by-step how to
implement it correctly in SPSS by replicating an example
from Chatterjee and Hadi (2006). We choose to replicate an
example from a standard textbook, rather than providing our
own, in order to convince the reader that the steps taken here
are the correct ones. The example demonstrates the
importance of the PCR, as it produces estimates that have the
expected signs and are statistically significant at the
1-percent level, whereas the ordinary least squares (OLS)
regression fails in that respect. This result becomes stronger
when we update the sample substantially. In addition, in
Sections 2 and 4, we use two other data sets, one from
Chatterjee and Hadi (2006) and another from Myers (1990),
to illustrate other important aspects of the PCR, namely, the
use of the correct formulas, in accordance with the choice of
scaling the variables; the choice of PCs to be dropped from
the PCR; and the conditions for the PCR to outperform OLS
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in the sense of the minimum mean square error (MSE)
criterion. Section 5 provides a summary.

2. An Account of the PCR and Some
Measures of Multicollinearity

2.1. Estimation of the Coefficients of Interest via the PCR

Consider the standard linear regression model with k
regressors, Xi, ..., X,
y=Xp+e, @)
where y is a nx1 response vector; X is a nx(k+1) regressor
matrix, whose first column is a vector of 1’s; p = (8o, b1, .-,
B is a (k+1)x1 vector of coefficients, where f, is the
constant term (or intercept) and Sy, ..., Sk are the slopes
(usually the only coefficients of interest) collected in the
slope vector B°= (B, ..., Bi)'; € is a nx1 vector of errors; and n
is the number of observations. For the i-th observation,
Equation (1) is
Yi = fot+ fxe + .t BiXa T & (1a)
Under the classical assumptions, the ordinary least squares
(OLS) estimator of B, P = (X'X)*X'y, is the best linear
unbiased estimator (BLUE).
To implement the PCR, we first write (1) in terms of
standardized variables,

¥ =X0+8, @)
where Y is the nx1 vector of the standardized response
variable, whose i-th element is defined as §; = (y; — Y)/s, ,

where Y is the sample mean of y and S, is its standard
deviation, so that ¥ has zero mean and unit standard

deviation; X is a nxk matrix (without a column of 1’s)
whose ij-th element is defined as X;; = (X; — X, )/s;,

where Xi is the sample mean of X; and s; is its sample
standard deviation (s;>0),j =1, ..., k, i =1, ..., n; 0 is kx1;
and € is a nx1 error vector whose i-th (unobserved) value
is & =(&—&)ls,, where & is the sample mean of ¢.

We assume that Equation (2) is correctly specified; the X’s
are stochastic, but strictly exogenous, implying that

E(& | X)=0, i=1,..n;and Cov(g|X)=E(EE'|X)=

o?l_, where ¢®> 0 and I, is the identity matrix of order n.

Note that the literature on the PCR almost invariably
assumes non-stochastic regressors, but here we adopt the
assumption of stochastic regressors, because: (1) it is more
realistic; (2) it renders the results more naturally
interpretable, in that they are viewed as conditional on the
observed values of the regressors; and (3) it has been adopted
by famous modern econometrics textbooks, such as Hayashi
(2000), Stock and Watson (2003), and Wooldridge (2006).

n?
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Under these assumptions, the OLS estimator of 6, denoted
as 0., is BLUE. The vector 0 is related to the slope
vector B° as follows: 6, = (si/s,)5;, j = 1, ..., k, or

-1 S
0=s,"Sp",

where S = diag(sy, ..., Sk) is a kxk diagonal matrix, with s,, ...,
S¢ in its main diagonal, so it is positive definite (Hadley, 1961,
p. 260). Thus, f; = (s,/5j)8;, j = 1, ..., k, so we can estimate the
fs through the #s (Chatterjee and Hadi, 2006, pp. 242 and
260):

B, =,15)0;, Bo=Y-Z.B%, j=1 ..Kk(3b)

Principal components are k orthogonal variables, Cy, ...,
Cy, defined as the following linear combinations of the
standardized regressors:

(3a)

C= XV. 4)

Here, V is a kxk matrix of the eigenvectors of the
correlation matrix of the regressors with the property VV' = I,
hence V' = V*and (V') =V, where V' is the transpose of V.
Thus, inserting VV' into (2) and using (4), Equation (2) can
be restated in terms of the PCs, since ¥ = XVV'0+& can
be written as

y=Ca+§, 5)

where a is a kx1 vector of new coefficients, defined as
a=V'0, hence 0=Va. Thus, the OLS estimators of
0 and o are related as follows:

A

0, =Va. (6)

To prove (6), post-multiply (4) by V', use VV' = 1, to
get X = CV', and note that O, = (X'X)'X'y =
(ve'evH)'ve'y=  (V)HC'O)tvivC'y =
V(C'C)'C'y = Va, since it is obvious from (5) that,
when all the (k) PCs are retained, the OLS estimator of @ is
a=(C'C)™"C'y, which, under the classical assumptions,
is BLUE. Pre-multiplying (6) by V" and using V' = V! yields
a=V'0,. (7)

So far, we have included all the (k) PCs, so the PCR results

in the same BLUE éOLS and ﬁOLS that would be obtained

by applying OLS to Equations (1)-(2), so it is of no practical
interest, as the idea of the PCR is to escape from these
imprecise estimators in the presence of multicollinearity. In
practice, we always want to drop d PCs whose variances are
close to zero or have no predictive power for ¥ in (5), and

hence also drop the corresponding d columns of V and the
corresponding d elements of @ . Let 0,. and P,. denote

the resulting PCR estimators of @ and @, which are biased
(Myers, 1990, p. 415). Thus, instead of (6), we want to have
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a relation between épc and the k — d retained elements of
@, collected in the (k-d)x1 sub-vector @, ,. Let @,

denote the dx1 sub-vector of the d dropped elements of @,
and partition V as V =[V, ,:V,], where Vi is the

kx (k-d) sub-matrix of the k-d retained eigenvectors, and V is
the kxd sub-matrix of the d dropped eigenvectors. Thus, (6)
is replaced by

A

Bpc = Vg0 g- ®)
Clearly, if we retain all the (k) PCs, i.e., if d = 0, then
Equation (8) reduces to (6), i.e., O,. = 0, and hence,

using Equation (3b), ﬁPC = ﬁOLS ; see Chatterjee and Hadi

(2006, p. 264, Table 10.3, and p. 231, Table 9.7) and
Rawlings (1988, p. 360).

Finally, (CO/(n-1) =V [(X' X)(n-1)]V=
A=diag(4,, ..., A,) is the covariance matrix of the k PCs,
where 14, ..., A are the eigenvalues of the correlation matrix
of the regressors, (5('5()/(n—1) (Hadley, 1961, p. 248), it
is useful to partition A as follows:

Ay 0
A { d } ©
0 A,

since

where A4 and A4 are diagonal matrices of order k-d and d,
respectively, whose elements in the main diagonal are the
eigenvalues associated with the retained and the dropped
PCs, respectively; the upper-right zero sub-matrix is (k-d)xd,
and the lower-left one is dx(k-d). Note that, since
(X' X)/(n—1) is positive definite, it follows that 1,> 0, ...,
A >0 (Goldberger, 1964, p. 34), so A is also positive definite,
and so are Ayxq and Ay. Applying the result of inverting a
partitioned nonsingular matrix to (9) (Hadley, 1961, pp.

107-109), we can now write the OLS estimator of a as
follows:

L‘f“ j ~ (CC)IC'y =—— AV

S
| =
[HEN

oy
} e (10)
1 (ALVey' X'y

B n-1 A;lvdlf(ly

2.2. Variance of éPC and f}PC , t-ratios, Bias, and Mean
Square Error

A

Consider the variance-covariance matrix of 0,
obtained from (8),

Cov(Bpc | X) =V, (Cov(a 4 | X)V, " py

But

2
(o}

a
Cov| ' |=c?(C'C)t=——A"
a, | X n-1
. (12)
(72 A;id
n-1l0 A}
so
~ 62
Cov(a,_4 | X) = _Aid ’ (132)
n-1
ie.,
Var(a,| X) = o*[(n-1 4,1,
- ) (13b)
Cov(a;,a, | X)=0,for j=I.
Substituting (13a) into (11) yields
2
Cov(8,c | X) = %—Vk—d AtV (14a)
Thus,
A ~ 02 k—d V2
_ —deliiy v
Var(t9j’PC | X) —EZM (7'), j=1..,Kk, (14b)

which shows clearly that if any of the eigenvalues is close to
zero, the variance of any or all of the elements of 0., (and

hence of ﬁpc) may be inflated. Note that, since we use

Chatterjee and Hadi’s (2006, p. 240) second type of scaling
the variables in (2), which are standardized with zero mean
and unit standard deviation (not unit length); and since the
A’s are the eigenvalues of the correlation matrix
(X' X)/(n—1), the division by n — 1 in (14b) is correct;
see McCallum (1970), Cheng and Iglarsh (1976), and Gunst
and Mason (1980, pp. 114-115). We stress this point, as the
various types of scaling used in the literature seem to be a
source of error. For example, in Chatterjee and Hadi’s (2006,
pp. 249-251) application of the PCR to the advertising data,
where the variables and the A’s are defined as above, the
authors fail to divide their Equations (9.34) and (9.35) by n—

1. Their calculation of the standard error of 91 is correct,
however, as it is based on their Equation (9.33), which is
correct.!

Now, using (3a), we can write ﬁ,ic = syS’lﬁ hence

PC!

* The data for this example are given in Table 9.9 of Chatterjee and Hadi (2006,
p. 236), where n = 22. Using the exact figures, and not the three-digit
approximations used by the authors, we confirmed that the eigenvalues of the
correlation matrix are indeed those given on p. 251, and that if their Equations

A

(9.34) and (9.35) are used, then the standard error of 91

calculated as 1.947. On the other hand, their Equation (9.33) and our Equation
(14b) both give the correct estimate of this standard error, which is 0.425 (=

is incorrectly

1.947/\/5 ). Note that Chatterjee and Hadi’s estimate of this standard error is
given on p. 253 and is slightly different, 0.438, because of rounding errors.
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Cov(Bi | X) =52S'Cov(,. | X)S™.  (150)

Substituting (14a) into (15a) and replacing ¢* with its
estimator (S%) based on Equation (5) that retains all the (k)
PCs yields the following estimator of (15a):

2 S’

Cov(B3c | X) =3, 1S VieeAsViea'S™. (150)
'n-
In addition, using (3b), we have that
Var(ﬁo,Pc | )~<) = Zl;:lijzvar(ﬁj,Pcl >~()
(15¢)

422 KX COV(S b el X).

The t-ratioof f3; o
k, since

=,Bj,Pc/S,éj,pc :[(Sylsj)éj,Pc]/[(Sylsi)séwc]

A

= ej’PC/Séj‘pc’ j:ll

isthe same asthatof &, . ,j=1,

Lk (16)

As we noted earlier, épc (and hence ﬁPC) is biased. To

calculate its bias, we follow Myers (1990, p. 415) and begin
by using (7), to obtain

A
A~

O 4=V 4005

(17a)
and

0y = Vd.éoLS : (170)

Substituting (17a) into (8) yields B,c =V, 4V, '8,
SO

E(épc | 5() = kadvk—d' E(QOLS | 5() = kadvk—dle’ (18)

A

6OLS

ViaVia +VuVy'=

is unbiased. Now, since VV' = |, we have that
I, hence V, (V. =1-V, V),
o (18) E0pc |X)=(I-V,V,)0 =
0-V,v,'e. (17b) we
E(6,|X)=V, E(0.,|X)=V, 0=a,.
Substituting in the previous equation yields E(()PC | X) =
0-V,a,, so

bias(,. | X) =E@,. | X)-0=-V,a,. (19

Goldberger (1964, p. 127) notes, however, that
“unbiasedness is not sacred” and reminds us of the
intuitively appealing minimum mean square error (MSE)
criterion, “which selects a biased estimator if its variance is
small enough to compensate for its bias.” Of course, the
minimum MSE and other criteria for choosing among
competing estimators are widely discussed in the literature

since

becomes

From have

(see, e.g., McCallum, 1970, Gunst and Mason, 1977, and Wu,
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A

2017). Using the MSE to choose between 0,. and 6OLS ,
we must determine whether the kxk  matrix

MSE(0,,< | X)—~MSE(@,. | X) is positive semi-definite,
in which case épc will be preferable. Since 60|_s is

unbiased, we have MSE((A)OLS |5():COV(60LS |X). But,
using (12), we obtain from (6) the following expression:
Cov(8,,s | X) = VCov(a| X)V' = [*/(n-1]VA™V".
Thus, we have

2

2
MSE(OOLS |X)— 1Vk dAk o Via +n_1VdA;lle-
(20a)
From (14a) and (20a) we obtain the kxk matrix
Cov(Bo5 | X) - Cov(B,c | X) = [02/(N-D)IV AV,

which is positive semi-definite, since Ay is positive definite
and the kxd matrix V4 has rank d < k (Rencher and Schaalje,

2008, p. 26, Corollary 2). Thus, the variance of épc will

never be greater than that of 60|_s , SO the burden of the
choice between the two estimators falls on the size of the
bias(0,. |5() If the cost (bias) of falsely omitting a PC

(underfitting) outweighs the gain (lower variance), the PCR
will fail to be a minimum MSE estimator.
By definition (see Goldberger, 1964, p. 129), we have

MSE (85 | X) = E[(85c —0)(B,c —6)' X] oo
= Cov(Byc | X) + [bias(0 | X)][bias(dc | X)]"

Substituting (14a) and (19) in (20b) gives
2

MSE (B, | X) = 1Vk AcsVied' + V040,V (200)

Subtracting (20c) from (20a) yields
MSE(éOLS | >~<) - MSE(épc | >~<)

(21)
=V, —040,)V,".
Following the same steps, one can show that®
MSE (B, | 5<) —MSE (B | X)
(22)
=5,57V, ( 1A a0V, ST
where BSOLS = (ﬂl,OLs’---'ﬁk,OLs)" ﬁ;c = (BI.PC""’BK,PC)"

and S is defined in (3a).
The kxk symmetric matrix in (21) will be positive
semi-definite if and only if all its eigenvalues are

2 The proof of Equation (22) is given in an appendix that is available from the
first author upon request.
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nonnegative (Goldberger, 1964, p. 37). Note that if the
matrix in (21) is positive semi-definite, then so is that in (22),
since the latter comes from the former by multiplying it by
the positive scalar s,” and by pre- and post-multiplying it by
the positive definite matrix S (see Hadley, 1961, p. 255). In
fact, (21) and (22) will be positive semi-definite if

2
o

- _1A;1 — a0, isa positive semi-definite matrix. (23)

Necessary, but not sufficient, conditions for (23) are (see
Goldberger, 1964, p. 37)

A(-14] - >0,j=1, ..., d. (24)

Thus, as a test of dropping the “optimal” number of PCs

(in the sense of the minimum MSE), we can start from the PC

with the smallest eigenvalue, or from the most insignificant

one in the regression equation (5), and keep dropping such

PCs until the conditions (24) are violated. Note that ford = 1,
(24) is also a sufficient condition, since in this case

[6?/(n-D]A;' — a0, is ascalar, so it can be factored

out in (21), and the kxk matrix that emerges, V4V4', is
positive semi-definite [Goldberger, 1964, p. 37, Property
(7.15) with P = V4. Note also that versions of (23) already
exist in the literature (see, e.g., McCallum, 1970, Farebrother,
1972, and O zkale, 2009). In particular, McCallum’s (1970, p.
112) condition (12) can be shown to be a special case of (23)
for k = 2 and considering the MSE of only one coefficient.

Consider the factors that enter (23) and favor the PCR over
the OLS estimator. First, the larger the error variance (¢°) is,
the more crucial it becomes to reduce the coefficient
variances via the PCR. Second, for the same reason, the
smaller the size of the sample (n), the higher the level of
uncertainty, and hence the larger the need for precision of the
coefficient estimates gained by applying the PCR. Third, the
smaller the eigenvalues associated with the dropped PCs are,
the more severe the multicollinearity problem is, hence the
more meaningful the application of the PCR becomes.
Fourth, the smaller the (absolute) values of the coefficients
of the dropped PCs (ay) are, the weaker the effects of these
PCs on the dependent variable, and hence the more
justifiable their removal from the PCR becomes.

Note that a difficulty with condition (23) is that it involves
unknown parameters. A way out is to use their unbiased
estimators (see McCallum, 1970, p. 112, Farebrother, 1972,
p. 335, and 0 zkale, 2009, p. 546). Since ¢” is inherited from
Equation (2) or (5), its estimate (s%), as well as the estimate of
ag, Should be obtained from the regression equation (5) that
retains all the PCs. In sum, we have the following

Proposition 1: ﬁPC outperforms ﬁOLS , in the minimum
MSE sense, if and only if the eigenvalues of the symmetric
dxd matrix [s*/(n—1)]A,;' —a,é," are all nonnegative.
Necessary  (but not sufficient) conditions are
s?/[(n —1)/11.]—0?]-2 >0, j=1,..,d wheres’and &, (an

element of dd ) are obtained from regression (5) that retains

all the PCs. As a test of dropping the “optimal” number of
PCs, one can start from the PC with the smallest eigenvalue
or from the most insignificant one in (5), and keep dropping
PCs until the condition is violated. For d = 1, the condition is
also sufficient.

2.3. Some Measures of Multicollinearity

The simplest measures of multicollinearity that one could
think of are the absolute values of Pearson’s pairwise
correlation coefficients (ri}) among the regressors. If k = 2,
this criterion is reliable, in that a “low” value of r;, means
absence of multicollinearity and a “high” value of r;, means
that multicolinearity is present. If k > 2, however, this
criterion is not reliable, in that, although “high” values of r;;
(at least one of them) still imply that multicolinearity is
present, nevertheless “low” values of rjj do not necessarily
imply absence of multicollinearity (Chatterjee and Hadi,
2006, pp. 233-237). Kmenta (1971, pp. 382-384) presents an
example with k = 3, where there exists an exact linear
relationship among the three regressors, i.e., there is perfect
multicollinearity, and yet none of the three rys exceeds 0.5 in
absolute value.

According to another simple criterion, multicollinearity is
considered harmful if, at a level of significance, say,
5-percent, the standard F statistic (for the hypothesis that the
joint effect of all the regressors is zero) is significant, but
all the t-statistics for the individual slope coefficients are
insignificant. As Kmenta (1971, p. 390) points out, however,
this criterion is too strong, since it considers
multicollinearity harmful only when all the t-statistics for the
slopes are insignificant, which makes it difficult to
disentangle the individual effects of the regressors on the
dependent variable.

Chatterjee and Hadi (2006, p. 233) suggest that
researchers should pay attention to the following indications
of multicollinearity: (i) large changes in the estimated
coefficients if a regressor is added or dropped, or if a data
point is altered or dropped; (ii) insignificant t-statistics for
regressors that are important, according to the pertinent
theory; and (iii) the signs of some of the estimated slope
coefficients do not conform to those expected (based on
theoretical grounds).

A well-known statistic that measures multicollinearity is
the variance inflation factor (VIF), defined as VIF; =
UTolerance;, where Tolerance; = 1 — R and R = the
coefficient of determination in the (auxiliary) regression of
X;j on the other regressors. Clearly, if the Xs are orthogonal
among themselves, then R?= 0 and VIF; = Tolerance; = 1, j =
1, ..., k. According to Chatterjee and Hadi (2006, p. 238), “a
VIF in excess of 10 is an indication that multicollinearity
may be causing problems in estimation.”

Another indication of the presence of multicollinearity is
that some eigenvalues are close to zero. Thus, as another
measure of multicollinearity, some authors suggest the

condition index (x), defined as x = ,/4,/A,, where J; and

Jp are, respectively, the largest and the smallest eigenvalue of
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the matrix X'X. By definition, x > 1. A large value of « is
evidence of strong multicollinearity, suggesting that the
inversion of X'X will be sensitive to small changes in X. As
an empirical rule, multicollinearity is considered to be
harmful when x > 15 (Chatterjee and Hadi, 2006, pp.
244-245).

The diagnostics of multicollinearity are often
complemented by the “variance proportions” in assessing the
effect of each linear dependency among the regressors on the
coefficient variances. In the OLS regression Equation (1), if
any of the eigenvalues of X'X is close to zero (indicating a
serious linear dependency), the variance of any or all of the

coefficients in P, s may be inflated. The variance
proportion p; is the proportion of the variance of the
coefficient f3 . ¢ attributed to the linear dependency

characterized by the eigenvalue 7; (see Myers, 1990, pp.
371-379).

3. Step-by-Step PCR in SPSS by
Replicating and Updating an Example

Chatterjee and Hadi (2006, ch. 9) illustrate the PCR by
estimating a linear imports function using French annual
aggregate data, 1949-1959 (n = 11), on Imports (IMPORT, y),
Gross Domestic Product (DOPROD, X;), increase in
Inventories (STOCK, X;), and Consumption (CONSUM, X3),
all measured in billions of French francs at 1959 prices.

165

Some useful descriptive statistics are Yy =21.891, X,

=194591, X,=3.3, X,=139.736,s, = 45437, 5, = 30, 5, =

1.6492, and s3 = 20.6344.

Note that in this example there are economic as well as
econometric reasons to believe that the classical assumptions
fail. For example, from the point of view of correct
specification, instead of including STOCK and CONSUM as
regressors, we would include the real exchange rate; and
from the point of view of time-series econometrics, we
would consider the problems of nonstationarity, endogeneity
of the regressors, and serial correlation. We refrain from
these issues here, however, and focus on the correct
application of the PCR.

In step 1, we apply OLS to Equation (1) and use the above
criteria to decide whether multicollinearity is harmful. After
entering the data in SPSS and selecting

Analyze > Regression > Linear > Statistics > Collinearity
Diagnostics

we get R* = 0.992 (coefficient of determination) and
Tables 1-2. The second and the fourth column of Table 1

report the elements of B, and O, . Note that the

coefficient ,@LOLS = -0.051 has the wrong sign and is

insignificant at all conventional levels (p-value = 0.488).
Economic theory suggests that domestic income exerts a
positive influence on imports, so we blame multicollinearity
for these unexpected results, and keep DOPROD for the
PCR.

Table 1. OLS estimates of g and 6°

UnstanQa_r dized Standa_lr(_jized Collinearity Statistics
Model Coefficients Coefficients t Sig.
B Std. Error Beta Tolerance VIF
(Constant) -10.128 1.212 -8.355 .000
1 DOPROD -.051 .070 -.339 -731 488 .005 185.997
STOCK .587 .095 .213 6.203 .000 .981 1.019
CONSUM .287 102 1.303 2.807 .026 .005 186.110
a. Dependent Variable: IMPORT
Table 2. Collinearity Diagnostics®
Variance Proportions
Model | Dimension | Eigenvalue Condition Index | (Constant) | DOPROD STOCK CONSUM
1 3.838 1.000 .00 .00 .01 .00
2 .148 5.086 .01 .00 .94 .00
! 3 .013 17.073 77 .00 .03 .00
4 5.447E-5 265.461 .22 1.00 .02 1.00

a. Dependent Variable: IMPORT

We obtain a large value of VIF; = 186 for DOPROD (see
Table 1), suggesting that multicollinearity is present indeed.
The high correlation coefficient between DOPROD and
CONSUM (ri3 = 0.997, see Table 3) confirms this
conclusion. The condition index is « = 265.46 > 15 (Table 2),
so this criterion, too, suggests that multicollinearity may be

harmful.® The linear dependency between DOPROD and
CONSUM is also revealed by the small value of the last
eigenvalue, A; = 0.00005447, accompanied by the extremely

% For an excellent theoretical discussion of the collinearity indices reported in
Tables 2 and 3, including their marginal values, see Myers (1990, pp. 123-133,
369-371) and Rawlings (1988, pp. 273-281).
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high  variance  proportions  of Var(,bA’l,OLS) and

Var (S, os) . namely, ps; = 0.9984 and ps; = 0.9989 (see
Table 2, where both of these values are rounded to 1). That
is to say, 99.84% of Var(ﬂlOLS) and 99.89% of

Var(ﬂl’OLs) can be attributed to the above linear
dependency.

Table 3. Simple correlations

DOPROD STOCK CONSUM

DOPROD 1 026 997"
STOCK .026 1 .036

CONSUM 997" .036 1

**_Correlation is significant at the 0.01 level (2-tailed).

Thus, in step 2, we estimate Equation (5). First, we need to
standardize the original variables by selecting

Analyze > Descriptive Statistics > Descriptives > (bring
into the dialog box all four variables) IMPORT, DOPROD,
STOCK, CONSUM > Save Standardized Values as
Variables (denoted as ZIMPORT, ZDOPROD, ZSTOCK,
ZCONSUM).

We can now obtain the PCs, the matrices V and C, and the

vector @ by selecting
File > New > Syntax

and by writing the following program in the command
syntax window that appears:

matrix. /* Comment: The dot at the end of each
command is necessary.

get x /variables ZDOPROD, ZSTOCK, ZCONSUM.

compute xtx=t(x)*x/10. /*We divide by n-1=10, since
we use the correlation matrix.

call eigen(xtx,eigvec,eigval).

print eigval. [* eigval is the wvector of the
eigenvalues of the correlation matrix.

print eigvec. [* eigvec is the correct matrix V.

compute c=x*eigvec. I* see Equation (4).

print c.

compute thetaols={-0.339; 0.213; 1.303}. /*  see
Table 1, 4™ column.

compute alpha=t(eigvec)*thetaols. I* see
Equation (7).

print alpha.

end matrix. /* To execute this program, do a right click
and select Run All.

Although this program produces the correct matrix V
directly, we will also construct it manually, in order to see
the error made by Liu, et al. (2003). First, select

Analyze > Dimension Reduction > Factor > (insert into
the dialog box the variables) DOPROD, STOCK, CONSUM >
Extraction > Fixed Number of Factors > Factors to Extract >
(enter into the dialog box) 3 (the number of the original
regressors) > Continue > OK.

Tables 4-5 report the results. The 3x3 “component matrix”

(Table 5) differs from that in Chatterjee and Hadi (20086, p.
243) and does not satisfy the property V'V =1, so it is not the
correct matrix of eigenvectors, as Liu, et al. (2003)
erroneously assume. Its elements need to be “normalized,”
i.e., its columns must be divided by the square root of the
corresponding eigenvalue, given by the second column of
Table 4. That is, the first column of this matrix must be

divided by ~/1.999, the second by 4/0.998, and the third

by +/0.002691. We thus obtain the correct matrix of
eigenvectors:
0.707  0.036 —0.707
V=| 0044 —-0.999 -0.007| (25
0.707  0.026 0.707
Table 4. Total Variance Explained
Initial Eigenvalues
Component Total % of Variance Cumulative %
1 1.999 66.638 66.638
2 .998 33.272 99.910
3 .002691* .090 100.000

Extraction Method: Principal Component Analysis.
%In the Table printed by SPSS this figure was rounded to 0.003.

Table 5.  Component Matrix®

Component
1 2 3
DOPROD 999 -.036 037
STOCK .062 998 0.000362"
CONSUM .999 -.026 -.037

Extraction Method: Principal Component Analysis.
a. 3 components extracted.
b. In the Table printed by SPSS this figure was rounded to 0.000.

As we noted earlier, 4; is the variance of the i-th PC. Here,
A3 = 0.002691, which is close to zero, suggesting that Cs is
almost a constant, and can be omitted, whereas keeping

it would inflate the s.e. of &, .. and hence that of f3; ¢ ;

see Equations (14b), (15a)-(15c). If Cs is included in the
regression equation (5), along with C; and C, (and no
intercept), its coefficient is 0?3 = 116, which is
insignificant at the 5-percent level (p-value = 0.095),
whereas the other estimates are the same as those of Table 6.
Thus, we estimate (5), using only C; and C, as regressors
(and no intercept), implying that the third column of V in (25)

is dropped.4 Table 6 reports the results.
Equation (5) does not suffer from multicollinearity, since

the PCs are orthogonal. The estimates ¢ =0.690 and

a,=-0.191 (Table 6) have no natural interpretation,
however, since the PCs are linear combinations of the

* The regressor sets {C1, C3}, {C2, C3}, {C2}, {C3} (and no intercept) all
produce insignificant coefficients.
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original variables, so they are used only as an intermediate
step to estimate the fs.

a,b,c

Table 6. Equation (5) with C; and C, as regressors

Unstandardized Standardized
Model Coefficients Coefficients t Sig.
B Std. Error Beta
1 C1 .690 .026 .976 27.032 | .000
c2 -191 .036 -191 -5.296 | .000

a. Dependent Variable: Zscore(IMPORT)
b. Linear Regression through the Origin
c.R*=0.988

Thus, in step 3, we get épc and ﬁpc and their standard

errors (s.e.). Using (8), where V4 is 3x2, and the above
estimates of oy and a,, we get

(Birc: 6y e, 0;0c) = (0.481,0.221,0.483).  (26)

Using Equation (14a), after replacing o with the estimate
s? = 0.010129 [obtained from the regression equation (5)
when all the three PCs are retained], we calculate

0.000259 —0.000021  0.000258
Cov(d,.) = 0.001030 —0.000011 | (27)
0.000258

(symmetric terms are omitted). In SPSS, (26) and (27) can
be obtained by running the following program:

matrix.

compute alpha2={0.690; -0.191}.

compute v2={0.707, 0.036; 0.044, -0.999; 0.707, 0.026}.

compute thetapc=v2*alpha2.

print thetapc.

/* This gives the estimates in (26).
compute Lamda2={1.999, 0; 0, 0.998}.
compute covtheta=(0.01029/10)*v2*inv(Lamda2)*t(v2).
[* This is Equation (14a).

print covtheta.

end matrix. /* To execute this program, do a right click
and select Run All.

Next, using (3b), we calculate the values of the ﬁpcs.

These estimates are reported in Table 7 (the PCR) and are the
same as those obtained by Chatterjee and Hadi (2006, p.

263).5 Table 7 also reports the estimated s.e.s of the ﬁpcs
and their t-ratios. The s.e.s are obtained from the matrix
COV(Bo.), which is calculated in accordance with
(15a)-(15¢c) and (27) and is reported below in (28) (the
covariances between ﬁAO’PC and the slope coefficients are
not reported, as they are almost never useful):

® Chatterjee and Hadi (2006, p. 263) report a slightly different estimate of the
intercept, namely -9.106, apparently because of rounding errors.
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1.005 - - -
cov(p )= - 0.0000059 —0.0000088  0.0000086 .
- 0.0078182 —0.0000065
- 0.0000125
(28)

Comparing the results of Table 7 with those of Table 1
(OLS), we observe that the major difference is that the
coefficient of DOPROD has now the expected sign and is
highly statistically significant. We conclude that the original
OLS estimate of this coefficient (-0.051) involves a large
sampling error, whereas the PCR yields a precise estimate
with the expected sign (0.0728) and s.e. = 0.0024, which is
about 30 times smaller than that of Table 1 (0.0703). The
other coefficients also have the expected signs and are highly
significant. Thus, the PCR is a substantial improvement over
the OLS estimator, and our decision not to drop DOPROD
turned out to be correct. Unfortunately, however, the
minimum MSE criterion does not support this conclusion, as
Proposition 1 fails, since 0.010129/(10x0.002691) — 1.16° =

-0.97 < 0, apparently because the coefficient 0?3 =1.161is
relatively large.

Table 7. Estimation of Equation (1) via the PCR, French annual data,
1949-1959°

Variable Coefficient Standard error t-statistic®
Constant -9.1407 1.0024 -9.12™"
DOPROD 0.0728 0.0024 29.90™
STOCK 0.6093 0.0884 6.89™"

CONSUM 0.1063 0.0035 30.07"

2 Dependent Variable: IMPORT;  the asterisks ~*" denote significance at the
1-percent level.

To check the robustness of these findings to substantial
changes in the sample, we now re-estimate Equation (1) with
French annual aggregate data, 1960-2018 (n = 59). The
variables are defined as before, but they are now measured in
billions of euros at 2010 prices. The source of the data is the
European Commission (AMECO Online). Again, we refrain
from the theoretical and the econometric issues referred to
earlier.

In the updated sample, multicollinearity is again strong, as
riz = 0.999, VIF, = 570 for DOPROD, VIF; = 576 for
CONSUM, « =172, the value of the smallest eigenvalue is 15

=0.0001, and the variance proportions of Var(/?lYOLS) and

Var(B, o) are pa = pm = 0.9994. Thus, following

exactly the same steps as before, we obtain and report the
OLS and the PCR estimates side by side in Table 8.

Again, the PCR is a substantial improvement over the
OLS estimator in that it produces estimates that have the
expected sign and are highly statistically significant. In
particular, the OLS estimate of the coefficient of DOPROD
(-0.848) is negative and statistically significant at the
1-percent level, an unacceptable result from the point of view
of economic theory, whereas the PCR eliminates this
obvious sampling error. Recall that in the case of the
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1949-1959 data, this coefficient was wrongly signed, but at
least it was insignificant at any conventional level. Thus, in

the updated sample, the PCR proves to be even
important.

more

Table 8. Estimation of Equation (1), French annual aggregate data, 1960-2018°

oLS PCR
Variable Coeff. s.e. t-ratio® Coeff. s.e. t-ratio®
Constant 21639 1654  -13.17" | -217.76 154212  -14.127"
DOPROD -0.848 0.255  -3.33"™ 0.175 0.0063 27.93™
STOCK 3.157 0550  5.74™ 3.592 0.5346 6.727
CONSUM 2.199 0.469  4.69™ 0.319 0.0113 28.35™"

2 Dependent Variable: IMPORT; ° the asterisks ™ denote significance at the 1-percent level.

Proposition 1 fails again, however. Here, s?> = 0.038767,
Jg = 0000873, n — 1 = 58, and @, = -3543, so

0.038767/(58x0.000873) — 3.543% = -11.78 < 0. The failure
of the minimum MSE criterion to support a theoretically and
empirically sound result suggests that other criteria for
comparing the PCR with the OLS estimator should also be
used. This is beyond the purpose of this paper, however; see,
e.g., Wu (2017).

4. Another Example, Where More than
One PCs are Dropped

To illustrate how Proposition 1 is implemented when more
than one PCs (not necessarily consecutive) are to be dropped
from the regression equation (5), we employ the “Hospital
manpower data” given in Myer’s (1990, pp. 132-133) Table
3.8, where n = 17 and k = 5. In this example, too,
multicollinearity is strong, as the bivariate correlation
coefficients are high and highly statistically significant, e.g.,
riz3 = 0.9999, ris = ry = 0.94, ri; = )3 = ryy = 0.91, whose
p-values for two-tailed tests are all 0.000; VIF; = 9598 and
VIF; = 8933; the condition index is x = 427; the last three
eigenvalues of the X'X matrix are 0.0447, 0.0082, and
0.00002848; and the two highest variance proportions are ps;
~ Pss ~ 0.999. In this example, we have s* = 0.012223; the
last three eigenvalues of the correlation matrix are A3 =
0.0946332, 1, =0.040712, and /5 = 0.00005397; and the PCs
C; and Cs are statistically insignificant in (5), since the

p-values of their estimated coefficients, @,=0.064 and &

= -1.301, are 0.493 and 0.735 (whereas the p-values of the
coefficients of C,, C,, and C, are 0.000000, 0.000976, and
0.001859). Thus, if we drop Cs only, Proposition 1 gives

0.012223/(16x0.00005397) — 1.301% = 12.46 > 0. (29)

The choice of PCs to be deleted is a debatable issue in the
literature. There are two strategies. The first deletes the PCs
that are associated with the smallest eigenvalues of the
correlation matrix, whereas the second deletes those that are
not significant in (5). Gunst and Mason (1980, pp. 327-328)
argue that “the first strategy often works better in practice
than the second, although the individual t tests can be more
effective if a very small significance level is used (say
a = .001). The rationale behind this suggestion is that the
decrease in variance associated with the deletion of

multicollinear components generally is much greater than the
bias incurred by doing so.” Myers (1990, p. 419) favors the
second strategy based on the individual t-values, which
“should be rank ordered and components be considered
for elimination beginning with the smallest t-value, in
magnitude” (Myers’s emphasis). Jackson’s (2003, p. 44)
advice is: “do NOT include pc’s in the model that do not
belong there statistically” (Jackson’s emphasis). With these
suggestions in mind, we choose to drop C; and Cs, because,
as we demonstrated earlier, they are highly insignificant.
Thus, in accordance with our Proposition 1, we must
calculate the two eigenvalues of the following 2x2

symmetric matrix:
00946332 0 |' [0.064

0012223 0% 7004 1501
17-1 |0 0.00005397 -1.301

{0.003977 0.083264}

0.083264 12.462516

(30)

They are 12.46 and 0.0034. Since both are nonnegative,
we conclude that the matrix is positive semi-definite, and

hence PB,. outperforms B, in the minimum MSE
sense.

5. Summary

In this paper, we revisit the PCR and show step-by-step
how to implement it properly in SPSS by replicating an
example of Chatterjee and Hadi (2006), in which the
regressors are highly collinear. The PCR proves to be
important, as it produces estimates that have the expected
signs and are statistically significant at the 1-percent level,
whereas the OLS fails in that respect. This result becomes
stronger when we update the sample substantially. Our main
motivation has been the fact that some researchers still fail to
implement this useful estimation method properly, despite
the strong warnings that already exist in the literature. As an
example of such a failure, we have briefly commented on the
paper by Liu, et al. (2003).

In addition, we use two more data sets from the literature
to illustrate other important aspects of the PCR, namely, the
use of the correct formulas, in accordance with the choice of
scaling the variables, the choice of PCs to drop, and the
conditions for the PCR to outperform OLS in the sense of the
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minimum MSE criterion.
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